
Light Stream Plugin - Unreal Engine

LSPlugin для Unreal Engine

Добро пожаловать на страницу документации LSPlugin.

⚙️ Установка LSPlugin

Скачайте плагин с официального сайта lightstream.pro.

Рекомендуем устанавливать LSPlugin в ваш проект, а не в сам движок. Таким образом вы не
потеряете настройки для каждого проекта. LSPlugin работает и протестирован под Unreal Engine
5.4 и выше с освещением Lumen.

Создайте проект в Unreal Engine с нужными для вас предустановками.1.
Создайте папку Plugins в в корневом каталоге вашего проекта в Unreal Engine.2.
Разархивируйте содержимое LSPlugin.zip в созданную папку Plugins.3.

https://lightstream.pro/ru/support/
https://www.lightstream.pro/ru
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:RootFolder.png


Запустите ваш Unreal Engine проект:

Зайдите в раздел Plugins в движке и найдите поиском Light Stream Plugin1.
Активируйте плагин, нажав галочку2.
Перезагрузить движок, если внизу появится надпись Restart3.

После установки плагина в верхней панели действий появится значок LSPlugin . Данная кнопка открывает
User Widget в отдельном окне. Widget является основной панелью управления плагина.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:PluginFolder.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Lspluginactivate.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:LS.png


Также для работы LSPlugin вам нужно включить или проверить включены ли у вас плагины DMX Engine и
DMX Protocol. Это встроенные в движок плагины.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Frame24.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:DMXE.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:DMXP.png


Начальная настройка

Запустите Unreal Engine и зайдите в настройки плагина DMX (Edit > Project Settings > Plugins
> DMX)

Добавьте Input Ports и в разделе Network Interface Card IP Address выберите адрес 0.0.0.0

⚠️ LSPlugin работает в режиме Broadcast

Экспорт анимаций из Light Stream

Вся работа с плагином в Unreal Engine, подразумевает, что у вас уже есть 3D модель
архитектурного объекта, а также уже готовы анимации в Light Stream.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Startsettings.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Startsettings01.png


Чтобы вывести анимации в формате *.CUE из программы Light Stream:

Запустите ваш проект с подсветкой в программе Light Stream1.
Зайдите в раздел Export.2.
Выберите нужные анимации галочками.3.
Выберите путь сохранения анимаций.4.
Нажмите кнопку Start и дождитесь окончания экспорта анимаций. По окончании экспорта снова5.
загорится кнопка Start.

Экспорт 3D модели из 3Ds Max

⚠️ Установите плагин Datasmith на ваш 3D пакет для дальнейшего экспорта и импорта модели в
Unreal Engine

Рассмотрим работу Datasmith на примере 3Ds Max.

Откройте ваш проект в 3Ds Max.1.
Включите вкладку Datasmith для отображения панели управления плагином2.
Выберите конкретные объекты в "Scene Explorer", для экспорта в *.uedatasmith и нажмите кнопку3.
"Export Selected". Выберите путь куда вы сохраните файл. Можно нажать копку "Exprot" и тогда будет
экспортирована вся сцена целиком.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:LightStreamExport.png
https://www.unrealengine.com/en-US/datasmith
https://www.unrealengine.com/en-US/datasmith


Работа с плагином
Сейчас мы разберём пошаговую инструкцию работы с плагином.

Запуск

Откройте ваш проект в Unreal Engine.1.
Создайте папку в корневом каталоге Content, где вы будете хранить файлы вашего проекта.2.

Запустите Light Stream Plugin нажав на значок  в верхней панели движка.

✴️ Вкладка "Import"

Импорт проекта из Light Stream

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:3dMax2.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:LS.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Zapusk.png


В первом пункте плагина в разделе "Import" вам нужно выбрать файл проекта Light Stream. Нажмите
Browse и откройте файл проекта (*.ls). Имя загруженного вами проекта, появится в шапке виджета
LSPlugin. Вы всегда сможете посмотреть с каким файлом проекта вы работаете.

Дополнительные иконки рядом с пунктами:

 - Предупреждающая иконка, говорит о том, что "Необходимо выполнить этот шаг" для
дальнейшей работы с плагином

 - Указывающая иконка, говорит о том, что вы "Не выполняли" данное действие. Иконка
пропадёт сразу как вы выполните данное действие. Это не обязывающее действие, которое
можно пропустить.

Эти значки помогают провести весь рабочий путь по LSPlugin.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Import.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Shapa.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Warn.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Quest.png


LS Plugin автоматически создаст папку в директории плагина, где будет хранить все необходимые
и загруженные вами файлы через виджет плагина. LightStreamPlugin / Data

Импорт IES

Во втором шаге виджета вам предлагается выбрать IES файлы вашего проекта, которые
автоматически будут подставлены в нужные светильники при соблюдении некоторых действий
описанных ниже. Также он их автоматически сложит в проект по адресу LightStreamPlugin

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:ViewPlug.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Browserfolder.png


/ Data / IES

Данный плагин имеет три возможности работы с *.IES файлами и их импортом.

Первый способ применения IES заключается в том, что изначально в 3D приложении вы расставляете
свои IES к нужным светильникам. Далее при работе с Light Stream вы создаёте кастомные
(пользовательские) Fixtures для светильников, которые используют одинаковую IES. После чего вам
нужно назвать IES файлы точно также как называются созданные в Light Stream кастомные Fixtures.
Далее в Unreal Engine в LSPlugin вы нажимаете "Browse" в пункте выбора IES и добавляете IES файлы
в проект UE. Теперь при нажатии кнопки "Spawn" IES автоматически подтянуться к одноименным
светильником проекта Light Stream.

Вторая возможность работы с IES не мешает использовать первый. Добавьте IES файлы в ваш проект
Unreal Engine использовав LSPlugin. Далее мы применяем IES до спауна светильников в Unreal Engine.
Зайдите в настройки LSPlugin, во вкладке "Scene Item Type IESs" вы можете выбрать для какого типа
будет добавлена одинаковая IES.

Третий подход к работе с IES. После спауна светильников вы переходите во вкладку Spawn в LSPlugin
и открываете таблицу "Setup spawn Data Table". Во вьюпорте найдите нужные светильники, в которых
вам нужно заменить IES. Посмотрите имя светильника в Outliner и найдите его в таблице. Выделите в
таблице нужный светильник и в нижнем поле настроек задайте светильнику нужную IES. Выполните
"Despawn" - "Spawn". К этой таблице вы можете обращаться в любое время для изменения IES.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Info_ies4.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:IESsettingsplug2.png


Импорт 3D модели

Третий шаг - это загрузка вашей модели в движок. Нажмите значок "Quickly add to the project"
в верхнем меню. Выберите "Datasmith > File Improt". Выберите файл *.udatasmith.
Далее выберите папку, в которую будет добавлена ваша модель. 3D модель будет добавлена в
сцену автоматически.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Rowsettings.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Datasmithimport.png


✴️ Вкладка "Spawn"

Описание вкладки "Spawn" LS Plugin

Spawn

Общее название вкладки

Setup spawn Data Table

Таблица настроек спауна светильников, которая дублируется также во вкладку Import

Spawn Despawn Reset

Спаун всех светильников, которые
есть в таблице "Setup Spawn Data
Table"

Убирает со сцены все
светильники, которые были
заспаунены

Полная отчистка проекта. Удаление
всех загруженных файлов, которые
были загружены через LSPlugin

Настройки | Spawn DT settings

Здесь вам предлагается Открыть основную таблицу настроек спауна светильников в сцену.

Все основные настройки в LS Plugin проходят в интерфейсе Data Tabl

В таблице "Spawn DT settings" отображаются все Fixtures, которые вы импортировали вместе с проектом
Light Stream (*.ls)

Описание колонок таблицы "Spawn DT settings"

Raw Name Fixture Name
Scene Item
Actor Class

IES Texture
Spawn
with IES

Override IES

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Spawn.png
https://dev.epicgames.com/documentation/en-us/unreal-engine/BlueprintAPI/DataTable?application_version=5.0
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Datatablerows.png


Уникальный
индификатор

Типа светильника. Тип светильника
соотносится с типом светильников в
программе Light Stream.

Fixture
Library
(LS)

Fixture
type (LS)

Fixture
Name (UE)

LED Pixel RGB RGB

LED
Wallwasher

Wallwasher Wallwasher

LED
Spotlight

Spotlight Spotlight

Выбранный
вами класс
светильника.
Если
говорить о
RGB, то у вас
есть 2
варианта
выбора
класса.
Оставить
дефолтным
или создать
Blueprint
самому.

Подгруженная
вами IES
текстура.

Выбор
спауна
светильника
с IES или
без

Заменит IES
вместо
подгруженного
вам IES из
LSPlugin на тот,
что будет в
блюпринте
Scene Item
Actor Class

Row Settings - детальные настройки каждого светильника в "Spawn DT settings" Fixture Name - Дублирует
колонку в таблице Fixture Name. Показывает тип Светильника (RGB, Wallwasher или Spotlight)

Scene Item Actor Class - Возможность выбора кастомного эктора для спауна Пиксей.

IESTexture - Показывает подгруженную IES текстуру. Если вы не подгружали IES через LSPlugin, то поле
останется пустым.

Spawn with IES - Настройка позволяет выбрать: спаунить с IES или без.

Override IES - Заменит IES вместо подгруженного вам IES из LSPlugin на тот, что будет в блюпринте Scene
Item Actor Class

✴️ Вкладка "Detailed"

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Rowsettings.png


Описание вкладки "Detailed" LS Plugin

Detailed

Название подраздела детальных настроек

Spline / Pixel Fixtures Allow / Deny

Дополнительные настройки, которые
действуют только на Spline / RGB Fixture
Name

Настройки, которые действуют
только на Wallwasher и
Spotlight

Разрешенные и не
разрешённые имена для
спауна.

Настройка "Spline / Pixel"

В таблице "Spline / Pixel" отображаются все добавленные светильники типа RGB

Описание таблицы "Spline / Pixel"

Row Name Rotate Static Mesh Static Mesh Rotation Static Mesh Relative Scale
Static Mesh

Relative Scale

Имя
сплайна

Разрешение
поворота мешей на
сплайне

Отображение углов
поворота мешей на
сплайне

Разрешение
масштабирование мешей на
сплайне

Отображение
масштаба

Поворот мешей на сплайне

После спауна сплайнов в сцену они все повёрнуты в одну сторону.

Что бы повернуть конкретный сплайн на котором находятся пикселе, найдите в Outliner или во
Viewport нужный сплайн и запомните его имя. Перейдите в таблицу "Spline / Pixel", найдите нужный
сплайн и внизу таблицы во вкладке Row Editor поставьте галочку напротив строки Rotate Static Mesh
и в строке Static Mesh Rotation введите нужные значения поворота.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Detailed.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:SplinePixtable.png


Поворот и масштабирование мешей на сплайне происходит в реальном времени, поэтому можно
смотреть сразу во Viewport и наблюдать за поворотом мешей.

Масштабирование мешей на сплайне

После спауна сплайнов в сцену масштаб пикселей равен 1:1 как в вашем "Scene Item Actor Class".

Что бы масштабировать ваши пиксели на сплайне, найдите в Outliner или во Viewport нужный сплайн
и запомните его имя. Перейдите в таблицу "Spline / Pixel", найдите нужный сплайн и внизу таблицы во
вкладке Row Editor поставьте галочку напротив строки "Static Mesh Relative Scale" и в строке Static
Mesh Relative Scale введите нужные значения масштабирования.

Настройка "Fixtures"

ИЗМЕНИТЬ ПО НАПОЛНЕНИЮ

✴️ Вкладка "Sequence"

Во влкадке Sequence представлен небольшой помошник для работы с Сиквенцией для дальнейшго создания
синематика.

В первом этапе вам предлагается добавить к проекту файлы анимаций из Light Stream в формате *.CUE

⚠️ Работа с анимация *.CUE доступна только пользователям Премиум версии Light Stream

После добавление анимаций они автоматически попадут в папку с плагином LightStreamPlugin /
Data / CUE.

Следующим шагов вам предлагается создать сиквенцию нажав на кнопку Create.

Далее в пункте 3 в поле вы можете выбрать свою созданную сиквенцию. И быстро переходить к её
редактированию нажав кнопку Edit

Работа в Sequencer

Откройте свою сиквенцию. Для добавление анимаций в формате *.CUE мы создали специальный очень

удобный трек специально для анимаций. Нажмите кнопку ADD  и добавьте Light Stream CUE

Track . Далее нажмите ПКМ на добавленной дорожке на тмайлинии и в разделе

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:SplinePixRowEdit.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Add.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Lscuetrack.png


Properties в пункте "LightStream CUEMovie Scene Section". Выберите нужную вам анимацю для
воспроизведения.

⚠️ Частота кадров анимации соответствует частоте кадров анимации в Light Stream и
автоматически подстраивается под частоту вашей сиквенции. Т.е. вне зависимости от частоты
кадров сиквенции анимации будут воспроизводится с той же скоростью, что и в LS.

� Light Stream - Settings

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Addcueprop.png


Описание настроек LSPlugin

Light Stream Plugin Settings
Настройки

плагина LSPlugin

Scene Item Classes
Библиотека
классов
светильников

Spotlight
Точечный
светильник
(Spotlight)

Класс светильника, который соответствует классу
светильника в Light Stream. По умолчанию это
стандартный Point Light или Spotlight в Unreal Engine

Wallwasher
Линейный
светильник
(Wallwasher)

Класс светильника, который соответсвует типу светильника
в Light Stream. По умолчанию это стандартный Rectangle
Light в Unreal Engine

Pixel Пиксель (RGB)
Класс светильника, который соответствует типу
светильника в Light Stream. По умолчанию. Это кастомный
меш и материал подготовленный специально для LSPlugin.

Scene Item Type IESs

Настройки
стандартного
пикселя для
спауна

Spotlight

IES для всех светильников типа Spotlight. Эта опция
заменит все IES на выбранную при спауне проекта. Если
оставить поле пустым, то приоритет будет отдан тем IES,
которые названы как Fixtures в LS (читай Import IES)

Wallwasher

IES для всех светильников типа Wallwasher. Эта опция
заменит все IES на выбранную при спауне проекта. Если
оставить поле пустым, то приоритет будет отдан тем IES,
которые названы как Fixtures в LS (читай Import IES)

Static Mesh для RGB - Default LSPlugin Pixel

Для визуализации пикселя используются примитивные меши. Cube или Sphere. Также можно использовать
любую форму меша учитывая, что материл будет применён на всю поверхность меша. Слоты материалов не
учитываются в базовой настройке меша.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:LSPsettingsdeffault.png


В дефолтном меше LSPlugin для визуализации пикселя мы используем полусферу.

Материал для RGB - Default LSPlugin Pixel

Мы долго работали над материалом (MM_Default_Pixel) и его отображения для визуализации пикселей. И
готовы предоставить вам наши результаты. Мы поставили наш материал вместе с LSPlugin и стандартным
мешем в виде полусферы для отображения пикселей. Здесь мы отталкивались не от реализма самого вида
пикселя, а от реализма его отображения в движке.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Meshdef_lit.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Meshdef_unlit.png


Данный материал работает в режимах Raster и Ray Tracing во вкладке Transluсency при добавленном в
проект PostProcessVolume.

Для того чтобы материал отображался правильно в каждом из режимов в Material Instance
(MI_Default_Pixel) есть галочка RayTracing_ON.

Если вы выбрали PostProcessVolume > Transluсency > Ray Tracing - поставьте галочку ✅

Если вы выбрали PostProcessVolume > Transluсency > Raster - снимите галочку ◻️

Так же вы вольны изменять материал по своему усмотрению. Только не забывайте сделать его резервную
копию, чтобы вернуться на исходные значения в случае поломки материала.

В режиме отображения Raster материал имеет эффект увеличения размера меша в зависимости от
удалённости камеры от объекта, что даёт больший запас отображения анимации пикселей на дальних
расстояниях, когда в сцене очень крупные объекты. В режиме Ray Tracing такая функция отсутствует. Но
опять же вы можете сами доработать данный материал.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:M%D0%B0terialview.png
https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:Raytracingon.png


⚠️ Для правильного отображения на материала в режиме PostProcessVolume > Transluсency >
Ray Tracing рекомендуется применить данные команды в консоли или прописать их в Config файле
вашего проекта (Ваш проект / Config / DefaultEngine.ini)
r.RayTracing.Culling 0
r.Shadow.distanceScale 0

Кастомный материал и меш.

Простой.

⚠️ Вы можете создавать свой кастомный материал для RGB, главное чтобы в материале цвет
задавался Constant3vector или Constant4vector конвертируемые в Parametr с именем Color

Применение простого кастомного материала и меша.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:4vector.png


Созданный вами BP с материалом или мешем Вы можете заменить в настройках самого LSplugin в его
настройках. Зайдите в меню Unreal Engine Edit > Project Settings в правом списке в разделе

Engine найдите Light Stream. Далее в окне настройки плагина в разделе Pixel в Scene Item Classes
выбрать созданный вами BP. После чего вам надо сделать "Despawn" и "Spawn" в окне плагина.

� Advanced

Создайте папку в каталоге своего проекта, в которой будет хранится кастомный BP. Создайте с обычным Actor
Class Blueprint > Actor class.

В этом блюпринте вы можете добавлять всё что угодно. Любой меш с любыми материалом, а после чего задать
какой меш будет дублироваться в сцене. Так же указать материал в каком меше и в каком слоте будет
использоваться как динамический для приёма DMX сигнала. Всё это осуществляется при помощи Light
Stream Interfaces.

https://ru.lightstream.pro/wiki/%D0%A4%D0%B0%D0%B9%D0%BB:SimplePixelBP.png

